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Preface
Scope
This manual describes how to operate Version 1.2.0 of the GDC TEAM 5553 UNIX softw
application. The TEAM 5553 software employs Simple Network Management Protocol (SN
to configure and control the operation of GDC SpectraComm 5553 Data Set Emulators (D
It can be launched under HP OpenView to run on a Sun Solaris workstation or a Hewlett-Pa
HPux platform. 

An SC 5553 DSE performs  the DTE interface functions of a fractional T1 data service unit 
(DSU). The DSE network interface takes place through the backplane of the SpectraComm she
in which the DSE is installed and a SpectraComm 5001 Line Terminating Unit (LTU) that is
nected to a T1 line. The LTU provides the SC 5553 DSE as many DS0s on the T1 line as
required to support its configured data rate. At the Telco central office, the T1 signal from
LTU is separated into individual DS0s, or bundles of DS0s, for routing to the appropriate 
nations. To a remote DSU the SC 5553 DSE appears to be a fractional T1 DSU. 

The TEAM 5553 application communicates with the DSE through a SpectraComm Mana
(SCM) card that also occupies the SpectraComm shelf. Control by the application can ex
also to remote DSUs that are connected to the DSEs under its local control. 

Operating instructions for the SCM appear in the TEAM Core Operation manual and operating 
instructions for the LTU appear in the TEAM 5001 Operation manual. 

This manual assumes you are familiar with HP OpenView and with DSU functions. 

Revision History
This is Issue 1 of the manual for TEAM 5553 Version 1.2.0. This version of the application
been upgraded to be compatible with Version 4.1 of the HP OpenView Operating System

Organization
This manual has five chapters. The information is arranged as follows:

• Chapter 1 - Introduction describes the TEAM 5553 application, the GDC SC 5553 DS
that you control with the application, and the TEAM environment in which the applica
operates, particularly the SCM that enables communication between the application
the DSEs it controls. 

• Chapter 2 - Operation provides directions for accessing the smaller individual 
applications that are responsible for the TEAM 5553 functions. It describes how to a
the functions from a shelf map window menu bar, and from the Select menu of a DSE
panel display. The chapter provides full descriptions of the TEAM 5553 applications
display read-only windows. It provides access information for the applications that dis
read/write windows and require greater operator interaction. 

• Chapter 3 - Configuration provides instructions for accessing the Configuration 
application and using it to set modem channel operating parameters. The chapter c
GDC 058R725-V120
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how to save configuration changes to the DSE or as templates at the controller works
and defines the parameters you can set. 

• Chapter 4 - Maintenance provides instructions for accessing the Maintenance applicat
and using it to control functions of the DSE. 

• Chapter 5 - Diagnostics provides instructions for accessing the Diagnostics application 
window and using it to perform test procedures. 

Document Conventions

Level 1  paragraph headers introduce major topics. 

Level 2  paragraph headers introduce subsections of major topics. 

Level 3  paragraph headers introduce subsections of secondary topics. 

This typewriter font shows output that is displayed on the screen. 

This bold font shows specific input that you type at the keyboard. 

This bold italicized font shows variable input that you type at the key-
board. 

Related Publications
The following documents have additional information that may be helpful when using this 
uct:

• TEAM Core Operation GDC 058R720-V160 

• TEAM 5001 Operation GDC 058R726-V200 

• TEAM Software Server Configuration GDC 058R723-V100 

• SpectraComm 5553 Data Set Emulator Installation & OperationGDC 076R108-000 

GDC publication numbers (e.g., GDC 032R101-000) are used to track and order technical ma
uals. Publication numbers use the following format: 

GDC NNNRnnn-000 or GDC NNNRnnn-Vnnn

• NNN identifies the product family (e.g. TEAM)

• R denotes a technical publication

• nnn a number assigned by Technical Publications

• 000 identifies a hardware product and does not change

• Vnnn the software version associated with a product may be updated periodically

The Issue Number on the title page only changes when a hardware manual is revised or w
manual is reprinted for some other reason; it does not automatically change when the softw
updated. A new Software Version is always Issue 1. Other specialized publications such a
lease Notes or Addenda may be available depending on the product. 

Notes present special instructions, helpful hints or general rules.

NOTE
GDC 058R725-V120
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Service and Support
General DataComm is committed to providing the service and support needed to install, ma
and maintain your equipment. For information about service programs or for assistance with
support requirements, contact your local Sales Representative or call General DataComm S
at the 24-hour, toll-free number listed below. 

• in the U.S. dial 1-800-243-1030

• outside the U.S. dial 1-203-598-7526

Be ready with the site name and phone number, and a description of the problem. The nex
able support representative will promptly return your call. 

Hands-on training courses are provided by GDC Educational Services. Courses range from
data communications, modems and multiplexers, to complex network and ATM systems a
taught in Connecticut or at a customer location. To discuss educational services or receiv
course schedule, call 1-800-243-1030 and follow the menu instructions. 

Safety Instructions

Safety Guidelines

The following symbols are used in this manual to draw your attention to potential hazards. A
tion indicates a hazard to equipment or data. A Warning indicates a hazard to personnel. 

Always use caution and common sense. Repairs must be performed by qualified service p
nel only. 

Caution statements identify conditions or practices that can result in 
damage to the equipment or in loss of data.

Warning statements identify conditions or practices that can result in 
personal injury or loss of life.
GDC 058R725-V120
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Glossary of Terms

Backplane Data Highway

High speed bus built into the SpectraComm Shelf backplane to support the exchange of da
timing signals between a line terminating unit and up to 24 data set emulators. The backpla
tains four data highways. Two backplanes, and their data highways, can be connected by
chain cables so that a total of 32 shelf slots are supported. 

Data Set Emulator (DSE)

Term for the units in the SpectraComm 5000 system that provide DTE interface functions.
DSE is designed to be compatible with a GDC device that can be installed as a standalone
a remote site. An SC 5553 DSE, for example, is compatible with a remote NMS 553 DSU

Line Terminating Unit

Term for the unit in the SpectraComm 5000 system that provides T1 network interface func
GDC 058R725-V120
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1  Introduction
Overview
This manual covers the General DataComm TEAM 5553 Unix Application. The application
be launched under HP OpenView to run on a Sun Solaris workstation or a Hewlett-Packa
HPux platform. You should be familiar with HP OpenView and with the operation of digital d
service units (DSUs) in order to use this manual effectively. 

The TEAM 5553 Unix Application is composed of integrated smaller applications that ma
various aspects of GDC SC 5553 Data Set Emulator (DSE) cards. The applications use t
Simple Network Management Protocol (SNMP). The SC 5553 DSE is part of the SpectraC
5000 (SC 5000) system. 

TEAM 5553 applications enable you to 

• Configure SC 5553 DSEs. 

• Monito r the operation of the DSEs through displays of Alarms and DTE Interface St
and through a Front Panel display that shows LED indicators as they appear on the
panel of the physical unit. 

• Diagnose suspected problems using local and remote loops (with or without an intern
generated test pattern). 

It also provides functions for performing the same range of tasks on an NMS 553 Data S
Unit (DSU) installed as the remote unit with which the SC 5553 DSE communicates. 

SC 5000 System Components
SC 5000 hardware consists of three types of components:

Data Set Emulator (DSE) – performs DTE interface functions in a manner that emula
the operation of a traditional data set directly connected to a telephone line. For exa
the SC 5553 DSE appears to its DTE and to its remote DSU to be a fractional T1 D
Rather than being connected directly to a Telco T1 line, however, the SC 5553 DSE
transmits and receives data through a data highway incorporated in the backplane of th
SpectraComm shelf. The data highway links the DSE to an LTU. 

Line Terminating Unit (LTU)  – performs network interface and channel grooming 
functions for a group of DSEs. An SC 5001 LTU connects to a T1 line, over which i
transmits the combined data traffic of up to 24 DSEs to a Telco switching site. On th
line the data for each DSE occupies one or more DS0s. Telco switching equipment r
the DS0s of the T1 line from the SC 5000 site to their individual remote destinations
this way a single T1 connection between an SC 5000 site and a Telco switching sit
support connections with up to 24 remote sites, depending on how many DS0s eac
requires. As a fractional T1 device, an SC 5553 DSE can employ from 1 to 24 DS0s
SC 5001 LTU is managed by the TEAM 5001 application. 

SpectraComm Manager (SCM) – acts as the SNMP agent through which TEAM 
management applications communicate with SC 5000 components. All manageme
GDC 058R725-V120
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communications are directed to the SCM card Internet Protocol (IP) address. The S
card relays commands and responses between management applications and hard
components, using a slot addressing scheme to communicate over the SpectraCom
backplane with the other SC 5000 components. The SCM is transparent to the applica
which operate as though they were communicating directly with the hardware units. 
SCM card is managed by the TEAM Core application, which is also responsible for t
Discovery and Mapping functions by which the applications keep track of the device
being managed. 

SC 5553 DSE
An SC 5553 DSE performs the functions of a GDC SNMP 553SD-1 DSU. 

TEAM 5553 Applications
The applications that make up the TEAM 5553 manager are grouped on menus under the
headings Performance, Configuration, Fault, and Misc (Miscellaneous). Menus for the 
applications are available in two ways: 

• From the menu bar of the shelf map window when an SC 5553 DSE is selected in th
window 

• From the Select button on the SC 5553 Front Panel display. 

SC 5553 Front Panel displays current status information on the SC 5553 DSE by displayi
states of the LED indicators on the front panel of the unit; provides Select button menus by 
you can invoke all other functions of the TEAM 5553 manager. Front Panel is a selection o
Performance menu in the shelf map window menu bar. You can also launch the Front Pa
display from that window by double clicking on the shelf icon of the DSE you need to work 

The following TEAM 5553 applications appear on both the Map window and Select button
menus:

• Performance: 

DTE Status – displays information on the status of signals in the DTE interface

Alarm Detail – furnishes detailed information about alarm state changes

• Configuration:

Configure – enables you to configure a selected SC 5553 DSE 

Maintenance – enables you to set device specific attributes that are not set as 
uration options

• Fault:

Diagnose – enables you to run diagnostic tests on a selected SC 5553 DSE

• Misc: 

Information – displays revision level information on the TEAM SC 5553 softwa

Front Panel Poll Rate – enables you to adjust the rate at which the application
the LTU while the Front Panel display is on-screen. 

Note Pad – provides access to a text editor. 
GDC 058R725-V120
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2   Operations
Introduction
The TEAM 5553 controller application consists of a group of smaller applications, each de
to a specific aspect of controlling or monitoring the SC 5553 Data Set Emulator. There ar
means of access to the TEAM 5553 applications: the shelf map menu bar, and the Front 
window Select button menus. This chapter describes both. 

There are two applications in the Performance category: Alarms displays alarm informatio
read-only window; DTE Status displays the status of signals in the DTE interface. This chapter 
fully describes both applications. 

There are two applications in the Configuration category: Configuration and Maintenance.
supports read/write windows by which you can review and alter DSE operating parameters
chapter describes how to access the Configuration and Maintenance applications. Instru
for using the two applications appear in subsequent, individual chapters. 

The Diagnostic application supports a read/write window by which you can command the
functions of the DSE and view test results. This chapter describes how to access the Diag
application. Instructions for using the application appear in a subsequent chapter. 

One item appears on the shelf map menu bar as Misc (miscellaneous): Information displa
read-only window that identifies the revision level of the TEAM 5553 application software. T
chapter fully describes this function, which can be accessed  from the Front Panel displa
clicking the mouse on the GDC logo that appears on the Front Panel.

Map Window Menu Bar Access
The table on the following page illustrates how the TEAM 5553 application functions are 
arranged on the menu bar at the top of the shelf map window. The table shows only the m
selections for the TEAM 5553 applications. The map window menus include selections in
addition to those that apply to TEAM 5553 because the window also provides access to other
applications. 

You must select the DSE you intend to work with before you open the menu you intend to
Select the DSE by clicking the mouse once on its icon in the shelf map.
GDC 058R725-V120
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The Performance menu Front Panel selection opens the Front Panel display window. The
button menus in the Front Panel display window include the selections that appear above
the exceptions of Front Panel under Performance and the Misc category. 

SC 5553 DSE Front Panel
The SC 5553 Front Panel display window (See Figure 2-1) provides a graphical interface to a 
selected SC 5553 DSE. You can launch a Front Panel in either of two ways:

• select the unit you intend to work with in the shelf map window, then select Front Pa
from the Performance menu for that window

• double click the mouse on the slot icon for the unit in the shelf map. 

The application responds by displaying a window that depicts the front panel of the SC 5553
unit. 

Menu Bar Menu Selections

Performance

Front Panel

Alarm Detail...

DTE Status...

Configuration

Configure...

Maintain...

Fault

Diagnose...

Misc

Information...
GDC 058R725-V120
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Figure 2-1 SC 5553 DSE Front Panel

The LEDs shown in the display reflect the states of the actual indicators on the physical u

INS – In Service
ON – Power On
SD – Send Data indicates when lit that the DSE is transmitting data, it displays a two
headed arrow to indicate transitions
RD – Receive Data indicates when lit that the DSE is receiving data from the remote D
it displays a two-headed arrow to indicate transitions
RS – Request To Send indicates when lit that the DTE has data to transmit, it displa
two-headed arrow to indicate transitions
CO – Carrier On indicates when lit that the DSE is receiving a signal, it displays a tw
headed arrow to indicate transitions
TMG – Timing is lit when the DSE is designated as the 8 kHz clock source for its sh
RSP – NMS Response
TM – Test Mode, is lit red while the DSE performs a diagnostic test; during a test 
employing Self Test a two-headed arrow superimposed on the LED indicates that er
have been detected 
GDC 058R725-V120
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ALM – Alarm, indicates by its color, which matches that of the SC 5553 Shelf submap
for the unit, that the DSE has detected an alarm condition. 
ST – Self Test is lit while the internal test pattern generator/checker is active. 
LT – Local Test is lit while the DSE is in the Local Loopback test condition. 
RL – Remote Loop is lit while the DSE is performing a remote loopback test with the
remote DSU. 
DL – Digital Loop is lit while the DSE is performing a digital loopback to direct data ba
to the remote DSU. 

The Front Panel screen displays the current operating speed of the DSE. 

The application polls the DSE to keep the states of the LEDs in the Front Panel display cu
The time of the most recent poll appears at the bottom of the Front Panel display, to the left
Help button. The time is displayed in white when Auto Poll is enabled, and in yellow when
disabled. 

The Select button, at the bottom of the Front Panel displays provides access to menus for 
of the TEAM 5553 application functions. The following table shows the arrangement of the
Select button menus. It differs somewhat from the arrangement on the Map window menu

The two Poll selections in the Select button menu determine when the application collects
information from the DSE to update the Front Panel window: 

• Selecting Demand Poll causes an immediate update of the display. 

• Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disab
automatic polling. If you select Disable, the Front Panel window displays a static snap
of the LED states as they were at the last poll, either when the window was launche
subsequent Demand Poll. 

Select Menu Items Second Level Selections

Performance

Alarm Detail...

DTE Status...

Configuration

Configure...

Maintenance...

Fault

Diagnose...

Demand Poll

Auto Poll (*)

15 seconds

30 seconds

60 seconds

Disable

Exit * Displays Off or poll interval
GDC 058R725-V120
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Each time the Front Panel display is opened, its initial polling rate is determined by the Fr
Panel Poll Rate selection of the map window Misc menu. 

The menu selection Exit dismisses the Front Panel window when you click on it. 

Common Window Features
Each TEAM 5553 application you select opens an on-screen window in which to operate.
number of features are common to many of the windows: 

Triangle button – in the title bar; reduces the window to an icon when you click on it. Doub
clicking on icon restores the window. This button appears on the top leve
window for each application.

Title bar – identifies the specific TEAM 5553 application running in the window; for 
example TEAM 5553 Main Configuration or TEAM 5553 Diagnostics 

Menu bar – always contains the selections File, on the far left, and Help, on the far r
File menu always contains the selection Exit, by which you can dismiss th
window; some window File menus contain selections special to the windo
Help menu provide access to information concerning the window. Some 
windows have additional Menu bar selections. 

The Menu bar appears on the top level window for each application. A Menu 
bar appears in the Main Configuration window, for example, but not in the
windows you access from Main Configuration.

Name field – identifies the SC 5553 the application is currently connected to by displa
the user-configured shelf name, followed by the DSE slot number, and th
user-configured device name. 

Descriptions in this manual of the individual TEAM 5553 applications identify window featu
that are specific to the applications, such as selections in the Menu bar and menus, and b

Performance Functions
Alarms

You can launch the TEAM 5553 Alarm application from the shelf map Performance Menu
from the front panel menu. The application displays the read-only Alarm Detail window for
selected DSE (See Figure 2-2).

The TEAM 5553 application gets alarm indications from the DSE in two ways: 

• By receiving traps that the SCM sends automatically in response to alarm conditions at the
DSE

• By polling the SCM for changes in alarm conditions at the DSE.
GDC 058R725-V120
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Figure 2-2 Alarm Detail Window

The Alarm Detail window displays alarms grouped into three categories: 

• Major

• Minor 

• Informational

Major Alarms

EEPROM Checksum – indicates that the non-volatile memory that stores the DSE 
configuration has become corrupted

DCD Loss – indicates loss of incoming signal

Timing Loss – indicates 

TxC Loss – indicates loss of transmit timing

Minor Alarms

RxD No Transitions – indicates Receive Data is not alternating one and zero states 
should

TxD No Transitions – indicates Transmit Data is not alternating one and zero states
should
GDC 058R725-V120
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Informational Alarms

Front Panel Test – indicates the DSE has been commanded into a test by means of i
panel switches 

DSR Loss – indicates the DSE is not outputting Data Set Ready to the DTE 

DTR Loss – indicates the DSE is not receiving Data Terminal Ready from the DTE 

EIA Test – indicates the DSE has been commanded into a test by means of a signa
the DTE at its EIA interface 

Alarm Detail Window Menus

The Alarm Detail window has a File menu and a View menu in its menu bar. 

The File menu contains only the selection Exit, by which you can dismiss the window. 

The View menu consists of three selections: Major, Minor, and Informational, each with a c
box beside it. To remove an alarm category from the window display, click on its check bo
that it is unchecked. Clicking a box so that it is checked restores the corresponding catego
the display. 

DTE Status

You can launch the TEAM 5553 DTE Status application from the shelf map Performance M
or from the front panel menu. The application displays the read-only Status window for the
selected DSE (See Figure 2-3). The window displays indicators for the states of the EIA signa
at the DTE interface. Dark green indicates Off, light green indicates On, and light green w
superimposed two-headed arrow indicates transitions. 

Status Window Menu

The Status window has a File menu in its menu bar with the selections Demand Poll, Auto
and Exit. 

Selecting Demand Poll causes an immediate update of the display. 

Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable aut
polling. If you select Disable, the Status window displays a static snapshot of the EIA indic
as they were at the last poll, either when the window was launched or a subsequent Deman

The time of the most recent poll appears in the bottom left corner of the window. The time
displayed in white when Auto Poll is enabled, and in yellow when it is disabled. 
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Figure 2-3 DTE Status Window

Configuration Functions
Configuration

You can launch the TEAM 5553 Configuration application from the shelf map Configuratio
Menu or from the front panel menu. 

When you launch the application, it initially displays the read-only TEAM 5553 Configurati
window, which has a File menu and a Navigate menu in its menu bar. 

The File menu contains the selections 

• Refresh, which discards all unsaved changes and restores all options in the displaye
configuration windows to the values they are assigned by the current operating 
configuration

• Save to Unit, which puts the new configuration into use by the DSE 

• Load Template, by which you can recall a stored configuration template that you can
save to the DSE either with or without modifications 

• Save to Template, by which you can store the current configuration on the workstatio
future use as a template 

• Compare to Template, by which you can identify differences between the configurat
displayed on-screen and a selected template 

• Exit, by which you can dismiss the window. 
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The Navigate menu enables you to access the four read/write windows by which you can 
configure various aspects of DSE operation: 

• System Options

• DTE Options

• Alarms Reported

• Add Remote

The TEAM 5553 Configuration application is fully described in Chapter 3, Configuration. 

Maintenance

You can launch the TEAM 5553 Maintenance application from the shelf map Configuratio
Menu or from the front panel menu. 

The application displays one read/write window by which you can control some aspects of
operation that fall outside the scope of Configuration. The TEAM 5553 Maintenance applic
is fully described in Chapter 4, Maintenance. 

Diagnostics
You can launch the TEAM 5553 Diagnostics application from the Fault Menu of the shelf m
or of the Front Panel display Select button menu. 

The application displays one read/write window by which you can control a variety of test 
functions on the DSE. The TEAM 5553 Diagnostics application is fully described in Chapter 5, 
Diagnostics. 

Miscellaneous Functions
Information

You can launch the TEAM 5553 Information window from the shelf map Misc menu or by do
clicking on the GDC logo in the Front Panel display. 

Information displays one read-only window that contains the name of the application, softw
revision level information, and copyright information. The File menu in the menu bar conta
only the selection Exit, by which you can dismiss the window. 

Figure 2-4 TEAM 5553 Information Window
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Front Panel Poll Rate

You can open the Front Panel Poll Rate window (See Figure 2-5) from the Misc menu of the Map 
window. The setting you select in this window determines the initial polling rate for Front P
displays each time they are opened. 

The rate selection is a global function. It selects initial polling rate for all front panel displa
linked to a TEAM Core application, regardless of which individual application you access it 
from. 

There are four selections, each accompanied by a checkbox: 

Slow 

Normal 

Fast 

Demand Poll Only 

The File menu in the menu bar contains two selections: Save to File and Exit. 

To set the desired polling rate, first click on the appropriate checkbox and then select Save
from the File menu. The precise polling frequency that results from a setting of Slow, Norm
Fast depends on a number of factors. The higher the rate, the more communication and pr
capacity is devoted to maintaining the display. 

The polling rate for an individual front panel display can be changed for the duration of a se
by means of the Auto Poll selection in the Select button menu. Changes you make with tha
selection are not retained when the display is closed. 

To dismiss the window, select Exit from the File menu. 

Figure 2-5 Front Panel Poll Rate Window

Note Pad

You can launch the Note Pad application from the Misc menu of the Map window. The 
application opens a shell tool on the workstation running the TEAM software. You can use
shell tool to run a text editor, mail tool, or any other software that resides on the workstation
Note Pad application provides this access for keeping records on the system. 
GDC 058R725-V120
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3   Configuration
Introduction
The TEAM 5553 Configuration application enables you to set all the options in the SC 5553
Set Emulator through a convenient group of configuration windows. 

To Start TEAM 5553 Configuration 
You can start the TEAM 5553 Configuration application by either of two methods: 

• Select a DSE symbol on the shelf map, then select Configure from the Configuratio
menu. 

• Click on the Select button of the Front Panel display, then click on Configuration an
select Configure from the resulting menu. 

Templates
You can store configuration settings as templates on the workstation that runs the TEAM
application. A template stores a configuration for the DSE options, and you can store as 
templates as you need. 

To load configuration settings from a template into the DSE you must perform the followi
steps: 

1. Select Load Template from the File menu and select the template from the resulting 
window. The application retrieves the configuration settings of the selected templat

2. Select Save to Unit from the File menu. The application makes the template configu
settings the current operating configuration for the DSE. 

Configuration Procedure
The following steps describe how to use the configuration application, and illustrate the 
functions of the Main Configuration window menus. 

1. Access the Main Configuration window, either from the submap or from the Front P
display. The application reads the current Main configuration from the DSE when
open the Main window. 

You can select to base your configuration changes on either the current configuratio
stored configuration template. In either case, the DSE continues to operate using it
unchanged current configuration. 

The Refresh selection on the Main window File menu causes the application to read th
current configuration from the DSE. All changes to all configuration windows that ha
not previously been saved to a profile or a template are lost when you select Refres

2. To edit the current configuration of the DSE, proceed directly to the Navigate menu 
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To edit a template, select Load Template from the File menu and select a template from
the resulting list. 

3. Click on the Navigate button to display a menu of the configuration windows, and sel
the one in which you intend to make changes. 

4. Make changes as needed in the configuration window. When you click on the inpu
for an option, a window opens to display all the values the field can be set to. Clic
mouse on the value you select. When you change the value or setting of an option, 
plication displays the option name and the new value in white, rather than black, type
remain white until you either save the changes to the DSE or a template by means
Main window File menu, or restore the option to its last stored value or setting. 

You can discard changes to a configuration window and return all its fields to their st
values in two ways:

• Click on the Reset button to discard changes while keeping the window 
open

• Click on the Cancel button to discard changes and close the window. 

You can close a configuration window without losing changes by clicking on either theOK 
button or the pushpin icon, which is located in the upper left corner of the window.

You can keep multiple configuration windows open on-screen and move between the
clicking the mouse on the one in which you intend to operate. The Main Configuratio
window remains on-screen throughout the configuration process. 

5. When you have accessed all the configuration windows that you need to and made
your changes, click on the File menu button of the Main Configuration window. From tha
menu you can select Save to Unit to save the new configuration in the DSE, or select Save
to Template to save it as a template in the workstation. 

6. When you select Save to Unit, the changed configuration for the DSE becomes the c
configuration. 

7. When you select Save to Template, a window appears containing a list of existing tem
and a field for entering a new template name. You can select an existing template
overwritten with the new configuration, or enter a name to create a new template. A 
template is available to be loaded by the application and then saved, with or without f
modification, to any SC 5553 DSE. 

Configuration Option Values

When you click the mouse on the entry field for a configuration item, a window opens conta
all the values that are permitted for that configuration item. Hold down the mouse button un
highlight is on the value you intend to configure, then release the button. The newly selected
appears in the entry field for the configuration item. 

Main Configuration Window
The Main Configuration window has two pull down menus, File and Navigate, that are the m
by which you carry out the actual process of configuring the DSE. From the Navigate menu you 
select the individual configuration windows in which you make changes. The File menu 
commands the storage and retrieval of configuration settings. The contents of the two me
appear below. 
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The Main Configuration window title bar displays the application name, TEAM 5553 
Configuration. The main body of the window contains read-only items that identify the DSE
provide information about its operations. 

Main Configuration Window Read-Only Display

The Main Configuration window displays the following read-only items:

Name: displays shelf and slot identification for the DSE 

Slot State: displays Active or Inactive

Operational Status: displays Up or Down

Serial Number: displays the serial number of the DSE

DTE Interface Type displays V.35 or EIA-530

Firmware Revision: displays the revision level of the DSE operating code

MIB Version: displays the revision level of the MIB files that enable SNMP cont

The TEAM 5553 application relies on the SCM and SC 5553 DSE to indicate when a 
configuration problem has caused an SNMP set error. 

Menu Buttons Menu Selections Further Selections

File

Refresh

Save to Unit

Load Template dialog window

Save to Template dialog window

Compare to Template dialog window

Exit

Navigate

System Options... 

DTE Options... 

Alarms Reported... 

Add Remote...

All Screens... 
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Figure 3-1 Main Configuration Window

System Options
The System Options configuration window contains two groups of options grouped under 
headings Miscellaneous Criteria and DS0 Criteria. 

Figure 3-2 System Options Configuration Window
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Miscellaneous Criteria

Front Panel – permits you to disable the switches on the front panel of the DSE as protect
against any inadvertent interruption of its operation. 

Options:

Enable – DSE front panel switches are operational. 

Inhibit – DSE front panel switches are disabled. 

Rsp Timeout – selects the length of time the SCM waits for a response from the unit befor
declares a No Response condition. 

Options:

2, 4, 6, 8 seconds

DS0 Criteria

Data Highway – read only field that identifies the backplane data highway the DSE is usin
exchange data with its LTU. The selection is made by the Shelf Configuration application t
part of the TEAM Core software. 

Options:

One

Two 

Three

Four

Aggregate Rate – read only field that displays the user data rate currently being supported b
DSE. When all DS0s assigned to the DSE are used for data, the aggregate rate is equal t
number of assigned DS0s times the DS0 format (56 kbps or 64 kbps). When Inband DCC
below) is configured for DCC DS0, the aggregate rate is equal to one less than the numbe
assigned DS0s times the DS0 format (56 kbps or 64 kbps). 

The assignment of DS0s to the DSE is performed in the Shelf Configuration application th
part of the TEAM Core software. 

DS0 Format – selects the data rate of each DS0 assigned to the DSE. When you select N 
for this option, the DTE Interface Configuration option Constant DCD is automatically force
Enabled. 

Options:

N x 56K 

N x 64K 

Inband DCC – selects the format of the Diagnostic Communication Channel (DCC) by wh
the DSE exchanges management communications with its remote DSU. 

Options:

None

Embedded – inserts the management channel in the overhead bits of the DS0s that c
user data. This type of DCC is available only when the selected DS0 Format is N x 5

DCC DS0 – causes the DSE to dedicate an entire DS0 for use by the management ch
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3-6 Configuration

nd the 

tion 

 

There must be a least two DS0s allocated to the DSE in order to employ DCC DS0, a
management channel occupies the last allocated DS0. 

DCC DS0 – read only field that identifies the DS0 being used for the Diagnostic Communica
Channel. This option is displayed only when DCC DS0 is selected for Inband DCC. 

Options:

2 – 24

DTE Interface Options
The DTE Interface configuration window contains three groups of options grouped under the
headings EIA Control, Control Signal Propagation, and Diagnostic Criteria. 

Figure 3-3 DTE Interface Configuration Window
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EIA Control

Data – selects the DSE to transmit and receive data as either normal or inverted signal st

Options:

TxD Norm, RxD Norm – transmit and receive data both use normal signal states

TxD Norm, RxD Inv – transmit data employs normal signal states, receive data is inve

TxD Inv, RxD Norm – transmit data is inverted, receive data employs normal signal st

TxD Inv, RxD Inv – transmit and receive data are both inverted 

Timing  – selects signal states of the DSE transmit and receive timing signals. 

Options:

TxC Norm, RxC Norm – transmit and receive timing signals both use normal signal state

TxC Norm, RxC Inv – transmit timing signals employ normal signal states, receive tim
signals are inverted

TxC Inv, RxC Norm – transmit timing signals are inverted, receive timing signals empl
normal signal states

TxC Inv, RxC Inv – transmit and receive timing signals are both inverted 

Ext Timing  – selects whether or not the DSE accepts external transmit timing from its DTE.

Options: 

Disable

Enable

Constant DSR – selects the DSE to output either a constant or a switched Data Set Ready 
to its DTE. 

Options: 

Disable – switched DSR signal

Enable – constant DSR signal

Constant DCD – selects the DSE to output either a constant or a switched Data Carrier De
signal to its DTE. This option is forced to Enable when you set DS0 Format to N x 64K in 
System Options configuration. 

Options: 

Disable – switched DCD signal

Enable – constant DCD signal

Ext LL Ctrl  – selects whether or not the DSE Local Loop function can be controlled from 
DTE. 

Options: 

Disable – DTE cannot control Local Loop

Enable – DTE can control Local Loop
GDC 058R725-V120
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Ext RL Ctrl  – selects whether or not the DSE Remote Loop function can be controlled from
DTE. 

Options: 

Disable – DTE cannot control Remote Loop

Enable – DTE can control Remote Loop

Control Signal Propagation

RTS/CTS Ctrl – selects the delay (if any) between the DSE receiving Request To Send fro
DTE and returning Clear To Send to the DTE. The DSE employs delay time to forward co
signals to its remote DSU. 

Options: 

Standard Delay – equivalent to three bit times 

10ms Delay 

RTS Forced On – no delay 

Diagnostic Criteria

RDL Response – selects whether or not the DSE can send and respond to a PN 127 remote
loop command. 

Options: 

PN 127 – DSE can transmit remote digital loop command to its remote DSU, and DS
initiates digital loop in response to command from the DSU

Disable – DSE does not transmit or respond to remote digital loop command

RDL Auto T/O  – selects whether or not the DSE ends remote digital loop automatically ba
on a timeout 

Options: 

10 Minutes – DSE terminates remote digital loop after ten minutes without need for fur
operator action. You can end the test manually before the timeout. 

Disable – remote digital loop continues until terminated by operator action.

Alarms Reported
The Alarms Reported configuration window (Figure 3-4) lets you configure which alarm 
conditions are to be reported for the DSE and which are not.
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Figure 3-4 Alarms Reported Configuration Window

Buttons and Option Selection

Each of the alarm options in the Alarms Reported configuration window has a small selec
field located to its left. You can select or de-select individual alarm options by simply click
the mouse button on the appropriate selection fields. When an option is selected for its ala
be reported, its selection field is highlighted. The selection fields next to alarm options tha
not to be reported are not highlighted. 

The Alarms Reported configuration window has two buttons positioned above the option f
Report All and Report None:

• Click on Report All to highlight all the alarm option selection fields. 

• Click on Report None to remove the highlight from all the alarm option selection field

After clicking Report All or Report None you can then change the state of individual fields 
needed. 

Alarm Options

DTR Loss – Loss of DTR alarm

DSR Loss – Loss of DSR alarm

DCD Loss – Loss of DCD alarm

TxC Loss – Loss of External Transmit Timing alarm

Timing Loss – Loss of Receive Timing alarm

EEPROM Checksum – Configuration Checksum error alarm

EIA Test – alarm indicating the DSE has been commanded into a test mode by the DTE

Front Panel Test – alarm indicating the DSE has been commanded into a test mode by mea
its front panel switches

TxD No Transitions – alarm indicating no transmit data from the DTE 

RxD No Transitions – alarm indicating no receive data from the remote DSU 
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The Add Remote configuration window (Figure 3-5) appears when you select Add Remote fro
the Main Configuration window Navigate menu. There must be an Inband DCC configured
the DSE in order for you to access this window. 

Figure 3-5 Add Remote Window

Procedure

Perform the following procedure to add the remote DSU: 

1. Select Add Remote from Main Configuration window Navigate menu. The Add Rem
window appears. The Serial Number field is blank when the window first appears. 

2. Click on the Wake Up Remote button. This commands the TEAM 5553 application to
ate the software structures that it requires in order to command and monitor the r
DSU in conjunction with the DSE. The application indicates success by displaying th
rial number of the associated remote DSU. 

3. Click OK to dismiss the window. 
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4   Maintenance
Introduction
The TEAM 5553 Maintenance application provides a group of functions for controlling the
operation of an SC 5553 Data Set Emulator. 

To Start TEAM 5553 Maintenance 
You can start the TEAM 5553 Maintenance application by either of two methods: 

• Select a DSE symbol on the shelf map, then select the Maintenance option from the
Configuration menu. 

• Click on the Select button of the Front Panel display, then click on Configuration an
select Maintenance from the resulting menu. 

The window title bar displays the application name, TEAM 5553 Maintenance. The Name
displays the shelf and slot identification for the DSE. See Figure 4-1.

Maintenance Window Buttons
The Maintenance window provides the following three buttons. 

Front Panel – permits you to enable or disable the hardware switches on the front panel o
SC 5553 DSE. The label on the button appears as either Inhibit Front Panel or Enable Fr
Panel, and it toggles between the two displays each time you click on the button. The button 
displays Inhibit Front Panel when the switches are enabled, and it displays Enable Front 
when they are disabled. 

Reset to Factory Defaults – causes all options in the DSE to return to their factory default 
settings. When you click on this button the application displays a warning “Resetting to fa
defaults will terminate communications to the unit. Do you want to continue?” Click on the
button in the warning window to complete the reset, or click on the Cancel button to canc
reset.  

Soft Reset – causes the DSE to perform a reset and resume operation using its current 
configuration. When you click on this button the application displays a warning “Performin
soft reset will terminate communications to the unit. Do you want to continue?” Click on the OK 
button in the warning window to complete the reset, or click on the Cancel button to canc
reset. 
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Figure 4-1 Maintenance Window
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5 Diagnostics
Introduction
The TEAM 5553 Diagnostics application enables you to perform a variety of tests on the 
5553 DSE. Tests can involve just the local unit (the DSE), or the local unit, the remote DSU
the telephone lines that connect them. 

 You can start the application by either of two methods: 

• Select a DSE symbol on the shelf submap, then select Diagnostics from the Fault m

• Click on the Select button of the Front Panel display, then click on Fault and select 
Diagnostics from the resulting menu. 

Diagnostics Window
Beneath the menu bar and the Name field the Diagnostics window (See Figure 5-1) is divided 
into three areas:

• Selection panel – contains buttons and check boxes for selecting, starting, and stop
test functions

• Graphic panel – depicts the path followed by test data during the current test 
• Time and results panel – contains an input field for specifying the duration of a test 

employs the DSE test pattern generator; displays Time Remaining and Test Result

The Diagnostics window menu bar contains File and Navigate. The File menu has only th
selection by which you dismiss the window. The Navigate menu also has a single selecti
History, by which you can access a display of test results (see Figure 5-6) accumulated during 
the current diagnostic session. 

Tests
The Diagnostics window selection panel lists four Tests to choose from, and two Patterns
can select for those tests that employ the DSE test pattern generator. The panel also inclu
buttons, Start Test and Stop Test. 

The following Tests are available: 

Local Loop (can be performed with or without test pattern) 
Digital Loop
Remote Loop (can be performed with or without test pattern) 
Delay

The two Patterns are: 

511 bit 
2047 bit 

Each Test and Pattern is accompanied by a check box on which you can click to select it
Pattern check boxes are grayed out when the selected Test cannot be combined with an 
test pattern. 
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Diagnostic Test Procedure

Perform the following steps to select and carry out a test procedure on the selected DSE.

1. Click on the check box next to the selected test: Remote Loop, Digital Loop, Local L
or Delay. 

2. If you have selected Local Loop or Remote Loop you can perform the test either w
internally generated 511 or 2047 test pattern, or with externally generated and check
ta. Under the Pattern heading, click on 511, 2047, or None (for external data). No P
selection is required for Digital Loop or Delay. 

3. If you are using an internally generated test pattern select, in the Test Time field, how
the test is to run before ending automatically. 

4. Click on the Start Test button. While the test runs, the graphic panel illustrates the da
employed by the test. If you are using an internally generated test pattern, the Tim
maining field counts down from 100 to 0 percent. 

During a test that employs an internally generated test pattern the Test Results field
displays Running: followed by the number of errors detected; it displays In Loop whe
external data is in use. When you perform the Delay test, the Test Results field displa
round trip time for a signal transmitted to and looped back by the remote DSU. 

5. If you are using an internally generated test pattern, the test ends automatically at t
of the specified Test Time. For any other test, click on the Stop Test button to end th
cedure. The Stop Test button can also stop a test with test pattern prior to the Tes
limit that would end it automatically. 

Figure 5-1 Diagnostics Window
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Diagnostics Table
The table below briefly describes the available tests. Each test is described more fully and
illustrated by a diagram under the headings that follow. 

 

Local Loop
The Local Loop test (See Figure 5-2) lets you isolate problems in the operation of the DSE a
the DTE interface. 

Figure 5-2 Local Loop Test

Test Description

Local Loop 
(without 
Pattern)

DSE initiates a local loopback, through which the DTE or external test 
equipment connected to the DTE interface can direct a test pattern. 
Must be ended by means of the Stop Test button. 

Local Loop 
(with Pattern)

DSE initiates a local loopback and activates its own test pattern gen-
erator/checker.

Remote Loop 
(without 
Pattern)

DSE commands the remote DSU to initiate a digital loopback. A test 
pattern from the local DTE or from external test equipment connected 
to the local DTE interface can then be directed through the resulting 
test path. Must be ended by means of the Stop Test button. 

Remote Loop 
(with Pattern)

DSE commands the remote DSU into digital loopback and activates 
its own test pattern generator/checker.

Digital Loop DSE loops data it receives from the remote DSU back to the remote 
DSU. Must be ended by means of the Stop Test button. 

Delay DSE determines delay time on the link by transmitting a signal to the 
remote DSU, which loops it back so that the DSE can measure the 
time required for the round trip.

In order to function, all Diagnostics procedures for the SC 5553 DSE 
require the unit to have data highway bandwidth allocated to it on the 
shelf backplane, and to be receiving shelf timing. NOTE

Enter test data at the DTE. Compare the data 
that was entered at the DTE with the data that 
is looped back and displayed by the DTE.

TX 
LOGIC

RX
LOGIC

Local Loop
HELLO SpectraComm

TX DRIVER

ANALOG
RECEIVER

D
T

E
 IN

T
E

R
F

A
C

E

(to LTU)

(from LTU)

Shelf Backplane
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Local Loop with Test Pattern
Because the pattern generator and checker are internal to the DSE, the DTE interface is n
of the Local Loop test path when you select a test pattern. The use of an internally genera
pattern enables the display of detected errors in the Test Results field. 

Figure 5-3 Local Loop with Self-Test

Remote Loop
In this test the DSE sends a PN 127 Remote Loop command to the remote DSU. In respo
remote DSU couples its receive data to its transmitter input for transmission back to the D
the local end (See Figure 5-4).
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Figure 5-4 Remote Loop
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    Enter test data at the
DTE. Compare data
entered at the DTE
with data looped back
and displayed by the
DTE. (Test equipment
can be used in place 
of the DTE.)
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Remote Loop with Test Pattern
In this test the local DSE sends a Remote Loop command to the remote DSU, then gener
test pattern that it transmits over the network to the remote DSU. The remote DSU loops 
received pattern to its transmitter and sends it back to the DSE for analysis (See Figure 5-5). This 
test checks the DSE, the remote DSU, and the link. 

The use of an internally generated test pattern enables the display of detected errors in th
Results field. 

Figure 5-5 Remote Loop with Test Pattern
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Digital Loop
In Digital Loopback (See Figure 5-5) local receive data is coupled to the transmitter input so t
the remote unit can perform a loopback test without commanding Remote Loopback. The r
DSU site is responsible for test pattern generation and checking in this test. 

.

Figure 5-6 Digital Loop

Diagnostics History
You can view a record of tests performed during the current diagnostic session by selectin
History from the Navigate menu in the Diagnostics window. The record appears as a listing
Diagnostics History window (see Figure 5-7). 

Figure 5-7 Diagnostics History

RX
Logic

DTE
Inter-
face

Backplane
Driver

Backplane
Receiver

TX
Logic

SC 5553 DSE

TX
Logic

DTE
Inter-
face

Analog
Receiver

TX
Driver

RX
Logic

Remote DSU

LTU

SC 5000 System

Backplane
GDC 058R725-V120



5-8 Diagnostics

 used 

 in 
nd re-

. 
The Diagnostics History displays information in five columns:

Start Time – date and time test began 

Pattern – test pattern used for the test; N/A when internally generated pattern is not

Test – name of the test 

Test Time – duration of the test, applies only to tests with test pattern

Test Results – “Idle: n Errors” for a completed test with test pattern; “Not in loop 
[STOPPED]” for a completed loop test without test pattern; “n ms” for Delay Test; “TEST 
STOPPED” for any test with test pattern that was ended by the Stop Test button 

To close the Diagnostics History window, click on either the OK button or the pushpin icon
the upper left corner of the window. During an on-going diagnostic session you can close a
open the Diagnostics History window without loss of display data. 

The application clears the Diagnostics History when you exit from the Diagnostics window
GDC 058R725-V120
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6 NMS 553
Overview
The SC 5553 Data Set Emulator is a central site unit that operates in conjunction with an
553 Data Service Unit (DSU) located at a remote site. The TEAM 5553 software supports
range of functions for the remote NMS 553 DSU, as it does for the SC 5553 DSE. This ch
describes the NMS 553 functionality of the software and provides instructions for its use

Access to the NMS 553 Functions
Access to the NMS 553 functions takes place through the icon for the SC 5553 DSE tha
linked to the NMS 553 DSU that you intend to work with. 

1. Display the shelf map. Any DSE that does not have an associated remote is identified 
a box around its icon symbol. Each DSE that has an associated remote is identified
icon symbol without a box. 

2. Double click on the icon symbol of the DSE that is linked to the DSU you intend to w
with. The application responds by opening a submap that displays icons for the DS
the DSU with a connecting line to indicate that together they form a link. 

3. From this submap you can either click once on the DSU icon to select it and then ccess
the functions through the menu bar of the submap window, or double click on the
icon to open the NMS 553 Front Panel display window. From the Front Panel displa
can access NMS 553 functions through Select button menus. 

Submap Window Menu Bar Access
The table on the following page illustrates how the NMS 553 functions of the TEAM 555
application are arranged on the menu bar at the top of the link submap window. The table
only the menu selections for the NMS 553 functions. The submap window menus include
selections as well because the window is accessible to other applications. 

You must click on the DSU icon to select it before you open the menu you intend to use
GDC 058R725-V120
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The Performance menu Front Panel selection opens the Front Panel display window, whic
provides access to menus through its Select button. All the menu selections shown above ap
in the Select button menus except Front Panel and the Misc category. 

NMS 553 DSU Front Panel
The NMS 553 Front Panel display window (See Figures 6-1 and 6-2) provides a graphical 
interface to remote NMS 553 DSU. You can launch a Front Panel in either of two ways: 

• select the NMS 553 icon in the submap window, then select Front Panel from the 
Performance menu for the window

• display the shelf sub-map that includes the unit you intend to work with, then double 
the mouse on the slot icon for the unit. 

The application responds by displaying a window that depicts the front panel of the sele
NMS 553 DSU unit. There are two NMS 553 DSU Front Panel displays, one for the mode
Intelligent Front Panel (IFP) and one for the model without IFP. 

Menu Bar Menu Selections

Performance

Front Panel

Alarm Detail...

Local Reports...

Alarm Counts...

Channel Status...

Configuration

Configure...

Maintenance...

Fault

Diagnose...

Misc

Front Panel Poll Rate...

Note Pad
GDC 058R725-V120
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Figure 6-1 NMS 553 IFP DSU Front Panel

Figure 6-2 NMS 553 Non-IFP DSU Front Panel

The LEDs shown in the display reflect the states of the actual indicators on the physical

SD – Send Data indicates when lit that the DSU is transmitting data 
RD – Receive Data indicates when lit that the DSU is receiving data 
ON – Power On
DSX – Cascade Port Indicator
Data – Management Data indicates when lit that the DSU is receiving data from th
TEAM controller
Resp – Management Response indicates when lit that the DSU is transmitting data
TEAM controller
ER – Error indicates when lit that a CRC error has been detected in receive data, 
flashes to indicate detected errors during test modes 
DSX OOF – Cascade Port Out of Frame indicator
DSX LOS – Cascade Loss of Signal indicator
NETWORK OOF – Network Out of Frame indicator
NETWORK LOS – Network Loss of Signal indicator
NETWORK BPV – Network Bi-polar Violation indicator
NETWORK AIS – Network Alarm Indication Signal indicator
LBK – Loopback (non-IFP only) indicates when lit the DSU is in a T1 loopback mo
TM – Test Mode 
ALM – Alarm, indicates by its color, which matches that of the NMS 553 submap ic
for the unit, that the DSU has detected an alarm condition. 

The application polls the DSU to keep the states of the LEDs in the Front Panel display cu
The time of the most recent poll appears in the bottom left corner of the Front Panel disp
The time is displayed in white when Auto Poll is enabled, and in yellow when it is disabl

The Select button on the Front Panel displays provides access to menus for the rest of th
553 functions of the TEAM 5553 application. The following table shows the arrangemen
the Select button menus. It differs somewhat from the arrangement on the submap wind
menu bar. 
GDC 058R725-V120
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The two Poll selections in the Select button menu determine when the application collect
information from the DSE to update the Front Panel window:

• Selecting Demand Poll causes an immediate update of the display. 

• Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to dis
automatic polling. If you select Disable, the Front Panel window displays a static 
snapshot of the LED states as they were at the last poll, either when the window w
launched or a subsequent Demand Poll. 

Each time the Front Panel display is opened, its initial polling rate is determined by the F
Panel Poll Rate selection of the map window Misc menu. 

The menu selection Exit dismisses the Front Panel window when you click on it. 

Select Menu Items
Second Level 

Selections

Performance

Alarm Detail...

Local Reports...

Alarm Counts...

Channel Status...

Administer

Configure...

Maintenance...

Fault

Diagnose...

Demand Poll

Auto Poll

15 seconds

30 seconds

60 seconds

Disable

Exit
GDC 058R725-V120
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Performance Functions
Alarms

You can launch the NMS 553 Alarm Detail application from the submap Performance Me
from the front panel menu. The application displays the read-only Alarms Detail window
the selected DSU (See Figure 6-3).

The TEAM 5553 application polls the DSU for changes in alarm conditions.

Figure 6-3 Alarm Detail Window

The Alarm Detail window displays alarms grouped into three categories: 

• Major

• Minor 

• Informational
GDC 058R725-V120
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Major Alarms

NV RAM Corrupt – indicates that the non-volatile memory that stores the DSU 
configuration has become corrupted

Unit Failure

Timing Loss

Network Loss of Signal

Cascade Loss of Signal 

Network Out Of Frame 

Cascade Out Of Frame 

Network Alarm Indication Signal 

Cascade Alarm Indication Signal 

Network Unavailable Signal State 

Cascade Unavailable Signal State 

Minor Alarms

Network Received Yellow

Cascade Received Yellow

Network Bipolar Violations

Cascade Bipolar Violations

Network CRC Errors

Cascade CRC Errors

Network Excessive Zeros

Network Low Average Density

Network Controlled Frame Slips 

Informational Alarms

Power Up

Status Change

Unsolicited Test Mode

Alarm Detail Window Menus

The Alarm Detail window has a File menu and a View menu in its menu bar. 

The File menu contains the selections Demand Poll, Auto Poll, and Exit. Selecting Deman
causes an immediate update of the display. 

Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable aut
polling. If you select Disable, the Alarm Detail window displays a static snapshot of condi
as they were at the last poll, either when the window was launched or a subsequent De
Poll. 

The time of the most recent poll appears in the bottom left corner of the window. The tim
displayed in white when Auto Poll is enabled, and in yellow when it is disabled. 

The View menu consists of three selections: Major, Minor, and Informational, each with 
GDC 058R725-V120
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check box beside it. To remove an alarm category from the window display, click on its c
box so that it is unchecked. Clicking a box so that it is checked restores the correspondi
category to the display. 

Local Reports

The Local Reports function displays AT&T statistics that are accumulated when the DSE
its remote DSU are configured to employ ESF frame formatting. The statistics are stored
internal registers of the DSU. You can launch the NMS 553 Local Reports function from
submap Misc menu or from the front panel menu. 

The Local Reports window menu bar contains File and Edit. 

The File menu consists of the selections Refresh and Exit. Refresh causes the applicati
update the window with any new data that is available from the DSU. Exit dismisses the
window. 

The Edit menu consists of the selections Clear Results and Resync Timer. Clear Results 
all entries currently stored for display in the window. Resync Timer enables you to selec
time that elapses before the application refreshes the window following a Clear Results.

Figure 6-4 Local Reports Window

Alarm Counts

You can launch the NMS 553 Alarm Counts function from the submap Misc Menu or from
front panel menu. The function displays accumulated alarm data divided into the three 
categories: Major, Minor, and Informational. 
GDC 058R725-V120



6-8 NMS 553

on to 
 

deletes 
t the 
 

nu or 
w for 
 at 
th a 

 Poll, 
The data is arranged in four columns: 

Alarm Type

Count – the number of occurrences that have been recorded 

First Occurrence

Last Occurrence

The Alarm Counts window menu bar contains File and Edit. 

The File menu consists of the selections Refresh and Exit. Refresh causes the applicati
update the window with any new data that is available from the DSU. Exit dismisses the
window. 

The Edit menu consists of the selections Clear Results and Resync Timer. Clear Results 
all entries currently stored for display in the window. Resync Timer enables you to selec
time that elapses before the application refreshes the window following a Clear Results.

Figure 6-5 Alarm Counts Window

Channel Status

You can launch the NMS 553 Channel Status window from the submap Performance Me
from the front panel menu. The application displays the read-only Channel Status windo
the DSU (See Figure 6-6). The window displays indicators for the states of the EIA signals
the DTE interface. Dark green indicates Off, light green indicates On, and light green wi
superimposed two-headed arrow indicates transitions. 

Status Window Menu

The Status window has a File menu in its menu bar with the selections Demand Poll, Auto
and Exit. Selecting Demand Poll causes an immediate update of the display. 
GDC 058R725-V120
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Auto Poll enables you to select updates at 15, 30, or 60 second intervals, or to disable aut
polling. If you select Disable, the Status window displays a static snapshot of the EIA indic
as they were at the last poll, either when the window was launched or a subsequent De
Poll. 

The time of the most recent poll appears in the bottom left corner of the window. The tim
displayed in white when Auto Poll is enabled, and in yellow when it is disabled. 

Figure 6-6 Channel Status Window

Configuration
You can launch the NMS 553 Configuration function from the submap Configuration Men
from the front panel menu. When you launch the window, it initially displays the read-on
NMS 553 Configuration window, which has a File menu and a Navigate menu in its menu

The File menu contains the selections 

• Refresh, which discards all unsaved changes and restores all options in the displa
configuration windows to the values they are assigned by the current operating 
configuration

• Save to Unit, which puts the new configuration into use by the DSU 

• Load Template, by which you can recall a stored configuration template that you can
save to the DSU either with or without modifications 

• Save to Template, by which you can store the current configuration on the worksta
for future use as a template 

• Compare to Template, by which you can identify differences between the configura
displayed on-screen and a selected template 
GDC 058R725-V120
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• Exit, by which you can dismiss the window. 

The Navigate menu enables you to access the four read/write windows by which you ca
configure various aspects of DSU operation: 

• System Options

• DTE Options

• Network Options

• Alarms Reported

Main Configuration Window

The Main Configuration window has two pull down menus, File and Navigate, that are th
means by which you carry out the actual process of configuring the DSE. From the Navigate 
menu you select the individual configuration windows in which you make changes. The File 
menu commands the storage and retrieval of configuration settings. The contents of the
menus appear below. 

The Main Configuration window title bar displays the function name, NMS 553 Configurat
The main body of the window contains read-only items that identify the DSE and provide
information about its operations. 

Main Configuration Window Read-Only Display

The Main Configuration window displays the following read-only items:

Name: shelf and slot identification for the master DSE followed by the 
slot:line:drop address of the DSU

Menu Buttons Menu Selections Further Selections

File

Refresh

Save to Unit

Load Template dialog window

Save to Template dialog window

Compare to Template dialog window

Exit

Navigate

System Options... 

DTE Options... 

Network Options... 

Alarms Reported... 

All Screens... 
GDC 058R725-V120
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Serial Number: displays the serial number of the DSU

DTE Interface Type displays V.35 or EIA-530

Firmware Revision: displays the revision level of the DSU operating code

NMS 553 MIB Version: displays the revision level of the MIB files that enable SNMP con

Figure 6-7 Main Configuration Window

System Options

The NMS 553 System Options configuration window contains two groups of options gro
under the headings Miscellaneous Criteria and DS0 Criteria. 

Figure 6-8 NMS 553 System Options Configuration Window
GDC 058R725-V120
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Miscellaneous Criteria
Front Panel – permits you to disable the switches on the front panel of the DSU as prote
against any inadvertent interruption of its operation. 

Options:

Enable – DSU front panel switches are operational. 

Inhibit – DSU front panel switches are disabled. 

Rsp Timeout – selects the length of time the SCM waits for a response from the DSU be
it declares a No Response condition. 

Options:

2, 4, 6, 8 seconds

DS0 Criteria
Allocation Scheme – selects between Alternate and Consecutive assignment of DS0s. U
alternate DS0s eliminates the need for ones density enforcement. Use of consecutive D
permits higher aggregate rates. 

Options:

Alternate

Consecutive 

DS0 Format – selects the data rate of each DS0 employed by the DSU. When you selec
64K for this option, the DTE Interface Configuration option Constant DCD is automatica
forced to Enabled. 

Options:

N x 56K 

N x 64K 

Starting DS0 – specifies the first DS0 of the group that the DSU employs to transmit and
receive its fractional T1 data. The Number of DS0s in the group is selected by the next o
When selecting the Starting DS0, remember that the group of DS0s cannot wrap around
upper limit. That is, you cannot assign, for example, 22 as the Starting DS0 if the Numb
DS0s is to be 5. Remember also to take the Allocation Scheme into account. 

Options:

Disabled

1– 24

Number of DS0s – specifies how many DS0s make up the group that the DSU employs t
transmit and receive its fractional T1 data. The number you specify here is only the DS0
actually carry data, regardless of the Allocation Scheme. 

Options:

1– 24

Aggregate Rate – read only field that displays the user data rate currently being supporte
the DSU. When all DS0s are used for data, the aggregate rate is equal to the number of a
DS0s times the DS0 format (56 kbps or 64 kbps). When Inband DCC (see below) is confi
for DCC DS0, the aggregate rate is equal to one less than the number of assigned DS0
the DS0 format (56 kbps or 64 kbps). 
GDC 058R725-V120
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Inband DCC – selects the format of the Diagnostic Communication Channel (DCC) by wh
the DSU exchanges management communications with its master DSE. 

Options:

Embedded – inserts the management channel in the overhead bits of the DS0s that
user data. This type of DCC is available only when the selected DS0 Format is N x

DCC DS0 – causes the DSU to dedicate an entire DS0 for use by the managemen
channel. There must be a least two DS0s allocated to the DSU in order to employ 
DS0, and the management channel occupies the last allocated DS0. 

DCC DS0 – read only field that identifies the DS0 being used for the Diagnostic 
Communication Channel. This option is displayed only when DCC DS0 is selected for In
DCC. 

Options:

2 – 24

DTE Options

The NMS 553 DTE Options configuration window contains three groups of options grou
under the headings EIA Control, Control Signal Propagation, and Diagnostic Criteria. 

Figure 6-9 DTE Options Configuration Window
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EIA Control
Data – selects the DSU to transmit and receive data as either normal or inverted signal stat

Options:

TxD Norm, RxD Norm – transmit and receive data both use normal signal states

TxD Norm, RxD Inv – transmit data employs normal signal states, receive data is inv

TxD Inv, RxD Norm – transmit data is inverted, receive data employs normal signal stat

TxD Inv, RxD Inv – transmit and receive data are both inverted 

Timing  – selects signal states of the DSU transmit and receive timing signals. 

Options:

TxC Norm, RxC Norm – transmit and receive timing signals both use normal signal st

TxC Norm, RxC Inv – transmit timing signals employ normal signal states, receive tim
signals are inverted

TxC Inv, RxC Norm – transmit timing signals are inverted, receive timing signals employ 
normal signal states

TxC Inv, RxC Inv – transmit and receive timing signals are both inverted 

Split Timing  – selects whether or not the DSU operates using split timing. In split timing 
is timed at the network interface by the Tx Clock Source selected in the Network Options 
configuration window, but timed at the DTE interface by external timing from the DTE.

Options: 

Disable

Enable

Constant DSR – selects the DSU to output either a constant or a switched Data Set Rea
signal to its DTE. 

Options: 

Disable – switched DSR signal

Enable – constant DSR signal

Constant DCD – selects the DSU to output either a constant or a switched Data Carrier D
signal to its DTE. This option is forced to Enable when you set DS0 Format to N x 64K in
System Options configuration. 

Options: 

Disable – switched DCD signal

Enable – constant DCD signal

Test Leads – selects whether or not the DSU Local Loop and Remote Loop functions ca
controlled from the DTE. 

Options: 

Disable – DTE cannot control loop functions

Enable – DTE can control loop functions
GDC 058R725-V120
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Control Signal Propagation
RTS/CTS Ctrl – selects the delay (if any) between the DSU receiving Request To Send 
the DTE and returning Clear To Send to the DTE. The DSU employs delay time to forwa
control signals to the DSE. 

Options: 

Standard Delay – equivalent to three bit times 

10ms Delay 

RTS Forced On – no delay 

Diagnostic Criteria
RDL Response – selects whether or not the DSU can send and respond to a PN 127 rem
digital loop command. 

Options: 

PN 127 – DSU can transmit remote digital loop command to the DSE, and DSU initia
digital loop in response to command from the DSE

Disable – DSU does not transmit or respond to remote digital loop command

RDL Auto T/O  – selects whether or not the DSU ends remote digital loop automatically b
on a timeout 

Options: 

10 Minutes – DSU terminates remote digital loop after ten minutes without need for
further operator action. You can end the test manually before the timeout. 

Disable – remote digital loop continues until terminated by operator action.

NMS 553 Network Options
The NMS 553 Network Options configuration window (Figure 6-10) appears when you selec
Network Options from the Main Configuration window Navigate menu. The window can 
tain two panels labeled Network and Cascade as shown below. When the selected DSU
not have the optional cascade interface installed, the application does not display the C
portion of this window. 

Figure 6-10 NMS 553 Network Options Configuration Window
GDC 058R725-V120
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Network Interface Options
Line Code – sets the line code the DSU employs on the T1 link. 

Options:

AMI – Alternate Mark Inversion, with no bipolar violations

B8ZS – Bipolar with eight zero substitution, with bipolar violations

Set Frame Type – sets the network framing format the DSU employs on the T1 link.

Options:

Manual ESF – Extended Superframe Format

Auto – DSU adapts itself to ESF or D4 according to which is being received

Manual D4 – D4 Superframe

Oper Frame Type – is a read-only field that displays the Line Type and Network Framing 
mat detected by the DSU.

ESF Mode – when you select ESF in the Set Line Type field you must set this field to ma
the type of Facilities Data Link maintenance messages that the service provider support

Options:

None – no FDL

ANSI T1.403 – Scheduled Performance Report Messages (PRMs) and Unscheduled
sages

TR 54016 – Telemetry Asynchronous Block Serial (TABS) protocol

Interface Type – sets the type of signal that the DSU transmits and receives through its network 
interface.

Options:

DS1 – for connection to a Telco network; Set Line Buildout field is valid when you se
DS1

DSX1 – for short haul connection to another on-site device; Pre-Equal field is valid w
you select DSX1

Pre-Equalization – sets pre-equalization when the selected Interface Type is DSX1. Shou
set to match line length between the DSU and the device it is connected to, thereby ens
that a satisfactory signal reaches the device.

Options:

None – provides no pre-equalization

0 to130 ft 

130 to 260 ft

260 to 390 ft

390 to 530 ft

530 to 655 ft
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Ones Density – sets the technique the DSU uses to ensure that its transmit signal contai
adequate proportion of digital ones (minimum pulse density) when the Line Code option fo
network side is set to AMI.

Options:

Inhibit – no minimum pulse density is maintained

Max 39 Zeros – maximum of 39 consecutive zeros can be transmitted to the networ
fore the DSU inserts a ‘one’

Max 15 Zeros – maximum of 15 consecutive zeros can be transmitted to the networ
fore the DSU inserts a ‘one’

8 (N+1) – the DSU enforces a minimum of N ‘ones’ per 8(N+1) bits, where N = 1 to 
the result is a 12% average ones density

Min 1 in 8 – the DSU enforces a minimum of 1 ‘one’ per 8 bits. Pulse density violati
are enforced but enforcement is not indicated.

Tx Clock Source – selects the timing source for transmissions at the network interface o
DSU. 

Options:

Receive – timing derived from the incoming T1 signal

Internal – timing from the internal clock of the DSU

Station – timing from an RS422 signal at the auxiliary port of the DSU

Cascade – timing from optional DSX-1 cascade port

Channel – external timing supplied at the channel interface

Fallback Clock Source – selects transmit timing source the DSU is to use if its primary sou
of timing is lost. The primary transmit timing source for a DSU is configurable. The prima
transmit timing source for a CSU is always receive timing. 

Options:

Internal/Local – timing from the internal clock of the DSU

Receive – timing from the incoming signal at the network interface

Inband Loopback Code – allows or prohibits the DSU from accepting a formatted (frame
unframed) in-band loopback code from another unit. The code initiates either Payload L
back (PLB) or Line Loopback (LLB). 

Options:

None – prevents DSU from accepting in-band loopback code

PLB-Unframed – DSU accepts unframed Payload Loopback code

PLB-Framed – DSU accepts framed Payload Loopback code

LLB-Unframed – DSU accepts unframed Line Loopback code

LLB-Framed – DSU accepts framed Line Loopback code
GDC 058R725-V120
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AIS Loopdown – sets the amount of time (in seconds) that the DSU must receive a continuous 
Alarm Indication Signal before terminating a remotely-initiated loopback. This option is gra
out when None is selected for Inband Loopback Code. 

Options:

5 - 60 seconds

Infinite

Set Line Buildout – sets the Network Line Buildout value when the selected Interface Typ
DS1.

Options:

Manual 0dB – provides no attenuation

Manual -7.5dB – provides -7.5dB of attenuation

Manual -15dB – provides -15dB of attenuation

Auto – provides attenuation based on the signal being received from the network

Oper Line Buildout  – is a read-only field that displays the Line Buildout value currently in
effect.

Cascade Interface Options
Line Code (C) – sets the line code the DSU employs at the DSX-1 cascade interface. 

Options:

AMI – Alternate Mark Inversion, with no bipolar violations

B8ZS – Bipolar with eight zero substitution, with bipolar violations

Set Frame Type (C) – sets the network framing format the DSU employs at the DSX-1 casc
interface.

Options:

Manual ESF – Extended Superframe Format

Auto – DSU adapts itself to ESF or D4 according to which is being received

Manual D4 – D4 Superframe

Oper Frame Type (C) – is a read-only field that displays the Line Type and Network Fram
format detected by the DSU at the DSX-1 cascade interface.

Pre-Equalization (C)– sets pre-equalization for the DSX-1 cascade interface. Should be s
match line length between the DSU and the device it is connected to, thereby ensuring 
satisfactory signal reaches the device.

Options:

None – provides no pre-equalization

0 to130 ft 

130 to 260 ft

260 to 390 ft

390 to 530 ft

530 to 655 ft
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Alarms Reported

The NMS 553 Alarms Reported configuration window (Figure 6-11) lets you configure which 
alarm conditions are to be reported for the DSU and which are not. The window can con
three panels labeled Network, Cascade, and Unit as shown below. When the selected DS
not have the optional cascade interface installed, the application does not display the C
portion of this window.

The Cascade alarms duplicate most, but not all, of the Network alarms, so the two categ
are treated together in the descriptions of Alarms Reported Fields that appear below. Th
alarms that occur only at the Network interface are identified in the descriptions. 

Figure 6-11 Alarms Reported Configuration Window

Buttons and Option Selection
Each of the alarm options in the Alarms Reported configuration window has a small sele
field located to its left. You can select or de-select individual alarm options by simply clic
the mouse button on the appropriate selection fields. When an option is selected for its al
be reported, its selection field is highlighted. The selection fields next to alarm options th
not to be reported are not highlighted. 

The Alarms Reported configuration window has two buttons positioned above the option f
Report All and Report None:

• Click on Report All to highlight all the alarm option selection fields. 

• Click on Report None to remove the highlight from all the alarm option selection fie
GDC 058R725-V120
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After clicking Report All or Report None you can then change the state of individual field
needed. 

Alarms Reported Buttons
Report All  – unmasks all alarms.

Report None – masks all alarms.

Reset – replaces the information in the fields with the most recently read information from
DSU. Note that this button does not initiate a read of information from the DSU.

OK  – saves your changes and closes the window.

Cancel – cancels your changes and closes the window.

Alarms Reported Fields
Network/Cascade

Loss of Signal – occurs when the DSU detects an absence of signal at the interface. Abs
of signal for a time equivalent to 175 bits (± 75) is considered no signal. 

Out of Frame – occurs when the DSU misses two out of four framing bits in the signal at
interface. The count for this alarm increments by one each time framing is lost, regardless
the number of frames affected. 

Received Yellow – occurs when a remote failure is detected at the interface.

Alarm Indication Signal  – occurs when the DSU receives an AIS at the interface.

Unavailable Signal State – occurs in response to 10 consecutive severely errored second
the interface. The state is considered cleared when the DSU has processed 10 consecu
onds of data without a severely errored second. 

Excessive Zeros – (Network only) occurs when Max 15 Zeros or Max 39 Zeros is the con
ured selection for Ones Density and the DSU has to insert ones in the signal it transmits t
the network. The selected option determines the threshold for ones insertion and occurre
this alarm. The DSU inserts ones when the transmit signal would otherwise contain fewe
than the Ones Density option requires.

When this alarm is valid Low Average Density is not. Neither alarm is valid when Inhibit is
option selected for Ones Density. 

Low Average Density – (Network only) occurs when 8(N+1) is the configured selection fo
Ones Density and the DSU has to insert ones in the signal it transmits toward the networ
DSU inserts ones when the transmit signal would otherwise contain fewer ones than the
Density option requires.

When this alarm is valid Excessive Zeros is not. Neither alarm is valid when Inhibit is the o
selected for Ones Density. 

Controlled Frame Slips – (Network only) occurs when the DSU drops frames to compens
for timing discrepancies with the network.

BPV – lets you mask or unmask Bipolar Violation alarms. A Bipolar Violation occurs when
signal the DSU receives at the interface does not alternate between signal levels as requ
Alternate Mark Inversion (AMI) or Bipolar with 8 Zero Substitution (B8ZS) data encoding
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If you unmask this alarm field, you must designate a window and a threshold. The windo
fines a time period within which the threshold must be exceeded in order for the DSU to
erate the alarm. For example, a window of one minute and a threshold of >100 specify tha
than 100 alarm events must be detected within the one minute window before an alarm 
erated.

Options:

BPV Window – report all, one second, one minute, one hour, or when threshold is re

BPV Threshold – minimum number of alarm events within the specified window requir
to generate the alarm: >10, >100, >1000, or >10,000

CRC – lets you mask or unmask CRC error alarms. A CRC error occurs when ESF fram
in use and the CRC-6 code calculated for a frame at the receiving unit does not match th
6 code calculated by the unit that transmitted the frame. The DSU performs CRC checki
every ESF frame to detect errors in the signal. 

If you unmask this alarm field, you must designate a window and a threshold. The windo
fines a time period within which the threshold must be exceeded in order for the DSU to
erate the alarm. For example, a window of one minute and a threshold of >100 specify tha
than 100 alarm events must be detected within the one minute window before an alarm 
erated.

Options:

CRC Window – report all, one second, one minute, one hour, or when threshold is re

CRC Threshold – minimum number of alarm events within the specified window re-
quired to generate the alarm: >10, >100, >1000, or >10,000

Unit Alarms

The following group of alarms appears under the heading Unit. 

Status Change – occurs when there is a change in the configuration of the DSU. 

Unsolicited Test Mode – occurs when the DSU is commanded into a test mode by mean
front panel switches.

Timing Loss – occurs when the DSU loses its source of Network Transmitter Timing. 

Configuration Functions – Maintenance
You can launch the NMS 553 Maintenance function from the submap Configuration Men
from the front panel menu. The application displays one read/write window by which you
control some aspects of DSU operation that fall outside the scope of Configuration. See Figure 
6-12. 

The window title bar displays the function name, NMS 553 Maintenance. The Name fiel
displays the shelf name and the slot number of the master DSE followed by the slot:line
address of the DSU. The File menu contains only the selection Exit, by which you can di
the window.
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Maintenance Window Buttons

The Maintenance window provides the following three buttons. 

Front Panel – permits you to enable or disable the hardware switches on the front panel o
DSU. The label on the button appears as either Inhibit Front Panel or Enable Front Pan
it toggles between the two displays each time you click on the button. The button displays 
Inhibit Front Panel when the switches are enabled, and it displays Enable Front Panel whe
are disabled. 

Reset to Factory Defaults – causes all options in the DSU to return to their factory defaul
settings. When you click on this button the application displays a warning “Resetting to fa
defaults will terminate communications to the unit. Do you want to continue?” Click on the
button in the warning window to complete the reset, or click on the Cancel button to canc
reset. 

Soft Reset – causes the DSU to perform a reset and resume operation using its current 
configuration. When you click on this button the application displays a warning “Performi
soft reset will terminate communications to the unit. Do you want to continue?” Click on 
OK button in the warning window to complete the reset, or click on the Cancel button to c
the reset. 

Figure 6-12 Configuration Maintenance Options Window

Diagnostics
You can launch the NMS 553 Diagnostics function from the submap Fault menu or from
front panel menu. 

The application displays one read/write window by which you can control a variety of tes
functions on the DSU. 
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Diagnostics Window

Beneath the menu bar and the Name field the Diagnostics window (See Figure 6-13) is divided 
into three areas:

• Selection panel – contains buttons and check boxes for selecting, starting, and sto
test functions

• Graphic panel – depicts the path followed by test data during the current test 

• Time and results panel – contains an input field for specifying the duration of a tes
employs the DSU test pattern generator; displays Time Remaining and Test Resu

The Diagnostics window menu bar contains File and Navigate. The File menu has only th
selection by which you dismiss the window. The Navigate menu also has a single selec
History, by which you can access a display of test results (see Figure 6-14) accumulated during 
the current diagnostic session. 

Tests

The Diagnostics window selection panel lists three Tests to choose from, and two Patter
can select for those tests that employ the DSU test pattern generator. The panel also incl
input field for the User Defined test pattern, and two buttons: Start Test and Stop Test. 

The following Tests are available: 

Channel Loop (can be performed with or without test pattern) 

Unit Test (performed only with test pattern) 

Digital Loop (performed only without test pattern) 

The Patterns are: 

511 bit 

2047 bit 

Each Test and Pattern is accompanied by a check box on which you can click to select 
Pattern check boxes are grayed out when the selected Test cannot be combined with an 
test pattern. 

Diagnostic Test Procedure

Perform the following steps to select and carry out a test procedure on the DSU. 

1. Click on the check box next to the selected test: Channel Loop, Unit Test, or D
Loop. 

2. Under the Pattern heading, click on your selected pattern, or None (for external d
you have selected a test that supports these options. No Pattern selection is requ
Digital Loop or Delay. 

3. If you are using an internally generated test pattern select, in the Test Time field
long the test is to run before ending automatically. 

4. Click on the Start Test button. While the test runs, the graphic panel illustrates th
path employed by the test. If you are using an internally generated test pattern, the
Remaining field counts down from 100 to 0 percent. 
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During a test that employs an internally generated test pattern the Test Results fie
displays the number of errors detected; it displays In Loop when external data is in

5. If you are using an internally generated test pattern, the test ends automatically at t
of the specified Test Time. For any other test, click on the Stop Test button to en
procedure. The Stop Test button can also stop a test with test pattern prior to th
Time limit that would end it automatically. 

Figure 6-13 NMS 553 Diagnostics Window

Diagnostics Table

The table below briefly describes the available tests. 

Test Description

Channel Loop 
(without 
Pattern)

DSU initiates a channel interface loopback, through which the DTE 
or external test equipment connected to the DTE interface can direct 
a test pattern

Channel Loop 
(with Pattern)

DSU initiates a channel interface loopback and activates its own test 
pattern generator/checker

Unit Test
(with Pattern)

DSU initiates a loopback at its network interface and activates its own 
test pattern generator/checker

Digital Loop DSU loops data it receives from the DSE back to the DSE
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Diagnostics History

You can view a record of tests performed during the current diagnostic session by selectin
tory from the Navigate menu in the Diagnostics window. The record appears as a listing 
Diagnostics History window (see Figure 6-14). 

Figure 6-14 Diagnostics History

The Diagnostics History displays information in five columns:

Start Time – date and time test began 

Pattern – test pattern used for the test; N/A when internally generated pattern is no

Test – name of the test 

Test Time – duration of the test, applies only to tests with test pattern

Test Results – “Idle: n Errors” for a completed test with test pattern; “Not in loop 
[STOPPED]” for a completed loop test without test pattern; “TEST STOPPED” for 
test with test pattern that was ended by the Stop Test button 

To close the Diagnostics History window, click on either the OK button or the pushpin ico
the upper left corner of the window. During an on-going diagnostic session you can clos
re-open the Diagnostics History window without loss of display data. 

The application clears the Diagnostics History when you exit from the Diagnostics windo

Miscellaneous Functions – Front Panel Poll Rate
You can open the Front Panel Poll Rate window (See Figure 6-15) from the Misc menu of the 
submap window. The setting you select in this window determines the initial polling rate
Front Panel displays each time they are opened. 

The rate selection is a global function. It selects initial polling rate for all front panel disp
linked to a TEAM Core application, regardless of which individual application you access it 
from. 

There are four selections, each accompanied by a checkbox: 

Slow 

Normal 

Fast 

Demand Poll Only 
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The File menu in the menu bar contains two selections: Save to File and Exit. 

To set the desired polling rate, first click on the appropriate checkbox and then select Sa
File from the File menu. The precise polling frequency that results from a setting of Slow
Normal, or Fast depends on a number of factors. The higher the rate, the more commun
and processor capacity is devoted to maintaining the display. 

The polling rate for an individual front panel display can be changed for the duration of a
session by means of the Auto Poll selection in the Select button menu. Changes you mak
that menu selection are not retained when the display is closed. 

To dismiss the window, select Exit from the File menu. 

Figure 6-15 Front Panel Poll Rate Window

Miscellaneous Functions – Note Pad
You can launch the Note Pad application from the Misc menu of the submap window. T
application opens a shell tool on the workstation running the TEAM software. You can us
shell tool to run a text editor, mail tool, or any other software that resides on the worksta
The Note Pad application provides this access for keeping records on the system. 
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